Kaiser Evacuates Patients Following Water Main Break

A water main break discovered during construction of their new emergency room Sunday caused Kaiser Permanente to shut down services. The hospital remained open for several days but suspended surgeries; as repair work continued, patients were transferred to other Kaiser facilities. “All patients safely discharged or transferred to other Kaiser facilities” said Dr. Greg Kelman. The last service to close was the emergency room. “Because the timeline for restoring water at the medical center campus is now estimated to be Saturday, January 25, we have determined that the safest decision for our members, patients, physicians and staff is to temporarily close services and facilities at this location,” Kaiser Permanente said. Reparation of the broken water main is estimated to be completed by this Saturday. Once state and local approvals are issued, it should take approximately two days to get back to full operations.

Calabasas Condo Owner Removes Hate Graffiti on Door

A condominium resident at Park Sorrento Condos in Calabasas removed hate-filled posters from the front of his residence late last week after city officials gave him 24 hours to do so. Residents and pedestrians complained about the messages he had posted on January 14, which included a swastika, racial comments and other derogatory slurs. Deputies responded to the complaints but were unable to act as there was no actual victim, and the messages could be construed as his First Amendment right to free speech. However, city officials met with him and ordered the removal, saying, “It violates city code covering inflammatory language and threats to others.” Reports indicate that the unidentified resident might have mental health issues and had caused problems previously within the complex.

Local Restaurants Feature “dineLA” Menus

dineLA week runs through January 31, and several local restaurants are offering special prix-fixe menus to showcase their offerings to local diners. Fleming’s Steakhouse in Woodland Hills is offering a three-course dinner for $59, and Il Fornaio at The Village at Westfield is offering both a $25 two-course lunch and $49 three-course dinner. Morton’s in Woodland Hills has a three-course dinner for $49, and Ruth’s Chris is also offering a three-course dinner for $59. In Calabasas Saddlepeak Lodge has a three-course dinner for $59, while Sugarfish has both a $20 lunch and a $39 dinner. For complete menus and list of all dineLA restaurants visit discoverlosangeles.com.

More of What’s Building 2020

High-Rise Residential Tower Planned - Apts, Hotel & Skydeck

Sandstone Properties has filed plans with the City for a 35-story high-rise residential tower at 6400 Canoga Avenue in Warner Center. The striking architectural design is a first of its concept for the area. “Entitlement and architectural firms have been engaged, and plans to develop a high-rise multi-family project with over 650 apartments have been filed,” according to the Sandstone website. Apartments will be available in studio, one-, two- and three-bedroom floorplans. There is also a 26-room podium hotel and restaurant planned, as well as an activity club and Skydeck. The project will occupy the remaining portion of the property, which now features a commercial building. The office building will remain open during construction. Sandstone acquired the property in 2018 for almost $28 million. Hetzel Design is the architect for the building.

Friday’s Being Demolished

The old T.G.I.Friday’s on Canoga Avenue is slated for the deep fryer! The iconic building is scheduled to be demolished later this year and a brand-new building, designed to be a restaurant, built in its place, to open June of 2021. Rumors on the street say that Ruth’s Chris, for years a tenant at Westfield Promenade, will be the new occupant. Frank Daftari, General Manager at Ruth’s Chris, would only comment that Ruth’s Chris has no intention of moving from Woodland Hills and will remain open in their current location for the foreseeable future.

Chick-fil-a Drive Thru at Winnetka

Can the chicken cross the road? A new Chick-fil-a, is under construction at Ventura Blvd and Winnetka. Chick-fil-a’s specialty is chicken sandwiches and fresh, homemade lemonade. All outlets are closed on Sundays. This is the fourth Chick-fil-a to open in the west valley in the last two years.

The new restaurant will offer dine-in and drive-through, with access and egress on both Winnetka and Ventura Blvd. Recent resident complaints about traffic at the Encino Chick-fil-a at White (Continued to page 13)
BOOK NOW THROUGH FEBRUARY 29, 2020!

ASK YOUR AAA TRAVEL AGENT ABOUT CURRENT OFFERS AND OTHER DESTINATIONS

CALL: (800) 741-1605
CLICK: AAA.com/TravelBenefits
VISIT: Your Local Auto Club Branch
People in the News

PASSINGS: Woodland Hills Rotarian Alice Muntean passed away January 17 after a long struggle with cancer. Friends and family members called her a strong lady, and a fighter, battling her disease for over eight years. She was “beautiful inside and out,” they said, ending each conversation with “All will be good.” Muntean had a long history as a Rotarian, active with their student youth exchange. She had several young people from different countries live with her over the years, including one who became her “son,” Joao Victor Gomes Santos from Brazil. He and Muntean formed a life-long bond. For years she worked as an underwriter at Athem. She is survived by her brother Gabriel Muntean. At press time no service arrangements had been announced.

HONORING THOSE WHO SERVE: The Woodland Hills Rotary Club honored the LAPD Topanga Station officers of the quarter this week. Sponsor of the event, Sandy Rosenholz of Senior Resources Inc., (far right) said, “It’s always a privilege and honor having the women and men police officers and employees from the LAPD Topanga Police Station visit our club and receive their awards.” Honored as “Officer of the Quarter” was Police Officer III Steve Norris. Honored as “Employee of the Quarter” was Detective III Dennis McNeal. “Civilian of the Quarter” was Sr. Equipment Mechanic Scott Allen. “Supervisor of the Quarter” was Sergeant I Marion Lindsey and “Detective of the Quarter” was Detective II Cesar Flores.

Students in the News

Chaeli Gutierrez and Chris Larson of West Hills have been named to the Dean’s List by Dr. Troy Shoemaker, president of Pensacola Christian College, for academic achievement during the 2019 fall semester.  

Ailin Alexin of Canoga Park graduated from Azusa Pacific University in December. Azusa Pacific University is an evangelical Christian university committed to God first and excellence in higher education.

Karis Brizendine of Agoura Hills majoring in acting, was named to the Dean’s List for the fall 2019 semester at Baldwin Wallace University, Ohio.

Two Premium Savings Rates – Just For You.

2-Year Jumbo Certificate

2.10% APY*  
with a minimum balance of $100,000  
kinecta.org/savings

High-Yield Money Market

2.00% APY*  
with a minimum balance of $100,000  
No monthly minimum balance fee  
kinecta.org/money-market

Open online – join Kinecta! kinecta.org/savings

Call 855.840.8641 or visit one of our locations:
21440 Victory Blvd., Woodland Hills, CA 91367

Visit kinecta.org/locations to find a branch near you.

*APY = Annual Percentage Yield
Rates and terms are accurate as of 1/17/2020 and are subject to change.
Membership requirements and certain restrictions apply.
Liquid Certificate and Regular Certificates require $1,000 minimum balance. Jumbo Certificates require $100,000 minimum balance. Offers may be modified or canceled by Kinecta at any time. 1.2% APY may be combined with VIP rate bonus offer and/or referred by another current or former member. 2.00% APY may be combined with VIP rate bonus offer and/or referred by another current or former member. 2.00% APY may be combined with VIP rate bonus offer and/or referred by another current or former member. 2.00% APY may be combined with VIP rate bonus offer and/or referred by another current or former member. 2.00% APY may be combined with VIP rate bonus offer and/or referred by another current or former member. 2.00% APY may be combined with VIP rate bonus offer and/or referred by another current or former member. 2.00% APY may be combined with VIP rate bonus offer and/or referred by another current or former member. 2.00% APY may be combined with VIP rate bonus offer and/or referred by another current or former member. 2.00% APY may be combined with VIP rate bonus offer and/or referred by another current or former member. 2.00% APY may be combined with VIP rate bonus offer and/or referred by another current or former member. 2.00% APY may be combined with VIP rate bonus offer and/or referred by another current or former member. No additional deposits accepted during certificate term. There is a penalty for early withdrawal. Fees and other conditions may reduce earnings. IRA certificates not applicable.

Students in the News

Chaeli Gutiierrez and Chris Larson of West Hills have been named to the Dean’s List by Dr. Troy Shoemaker, president of Pensacola Christian College, for academic achievement during the 2019 fall semester.  

Ailin Alexin of Canoga Park graduated from Azusa Pacific University in December. Azusa Pacific University is an evangelical Christian university committed to God first and excellence in higher education.

Karis Brizendine of Agoura Hills majoring in acting, was named to the Dean’s List for the fall 2019 semester at Baldwin Wallace University, Ohio.
In the 60’s people took acid to make the world weird. Now the world IS weird, and people take Prozac to make it normal. Go figure.

Local reader John Stevens joked that as a New Year’s resolution he was going to quit all his bad habits for 2020, but then he remembered that nobody likes a quitter!

The great George Carlin mused, “Have you ever noticed that anybody driving slower than you is an idiot, and anyone going faster than you is a maniac?”

As Californians mull the budget decisions handed down from Sacramento, we’re reminded of this from George Bernard Shaw: “A government which robs Peter to pay Paul can always depend upon the support of Paul.”

Or as former president and plain talker Ronald Reagan said, “the government is like a baby’s alimentary canal, with a healthy appetite at one end and no responsibility at the other.”

Lynn Homsy got a laugh with this one: While creating husbands, God promised women that good and ideal husbands would be found in all corners of the world. And then he made the Earth round.

We’re at the age...so I went in for my check up before a colonoscopy, and one of the many sheets of information they gave me was one informing me that Anthem Blue Cross is the only insurance company that does not cover anesthetic for a colonoscopy procedure! Seriously? Should I tell their execs to try it without? Or maybe just where to stick it?

Why isn’t phonics spelled like it sounds?

ERRATUM: We mistakenly misspelled UCLA sports medicine specialist Dr. Philip Cohen’s name. We apologize for any confusion.

ATTENTION ATTORNEYS:
We are adjudicated to run legal notices for all of Los Angeles County
SUMMONS • NAME CHANGES • PETITIONS • DBA’S • ABC • LIEN SALES
CALL VALLEY NEWS GROUP 818.313.9545

NEED A READ? WHERE TO PICK UP THE PAPER
Weiler’s Deli Victory Blvd.
West Valley Playhouse
Woodland Hills Tarzana Chamber – Promenade
Financial Partners Credit Union
First Bank Erwin Street
Follow Your Heart
Woodland Hills Library
Kaiser Permanente
Platt Library
Nat’s Coffee Shop
Nicola’s Kitchen
Gasolina
Bank of America Canoga Avenue
The Village at Westfield
Dean’s Bakery
Weiler’s West Sherman Way
Whole Foods Market
Tarzana Library
Cavareta’s Deli
Agoura Hills/Calabasas Community Center
Levi’s Deli Calabasas
King’s Fish Market
Calabasas Tennis & Swim Ctr.
Calabasas Senior Center
Premier America Credit Union
Gelson’s Market Calabasas
Wells Fargo
US Bank
Valley News Group – 22025 Ventura Blvd.
German Cold Cuts
Hilton Woodland Hills Lobby
Warner Center Marriott Concierge Desk
AAA Auto & Travel
Green Thumb Nursery Canoga Park
Winnetka Bowl
Calabasas Library and City Hall
Sagebrush Cantina
Calabasas Chamber Office
Ralph’s Calabasas
Albritton’s Calabasas
Marmalade Cafe
How to Improve Your Outlook Performance for the New Year

By Andy Takieddine

Since we have entered a new year, it is the best time to look at your email system and tune it for best performance. In this article we are going to tackle Microsoft Outlook system and performance.

Ever notice that your Microsoft Outlook account has slowed to a crawl? Basic email functions like send/receive acting a little funny? Consider checking the size of your mailbox. You might be shocked to discover just how bloated it is.

For most versions of Outlook, clicking on File > Folder > Properties > Storage — or right-clicking on any folder and selecting Properties — will display the total size not only of a chosen folder but also of any associated subfolders.

Outlook’s Auto Archive function is set to automatically back up deleted items, sent items, and expired tasks and calendar items. But if you get hundreds of messages per day and don’t delete them or move them from your inbox, you run the risk of sabotaging your account. Exceed 2GB of storage in an overstuffed inbox and Outlook really starts to run slow.

Yet solving the problem is doable. CMIT Solutions recommends that you or your IT department tackle Microsoft Outlook, clicking on File > Archive and change the date under archive items older than.

2. Create a new Archiving Rule. Click on Tools > Rules, select Exchange from the “On My Computer” section, and click the + near the bottom of the window. Name the rule something meaningful and recognizable, like “120 Days, Auto Archive.”

3. Define the time limit and destination for emails eligible for archiving. Under the “when a new message arrives” menu, change Date Received (we suggest 120-180 days) and then change “Do the Following” to a defined action like “Move Message + Archived Mail.” Click the check box for Enabled and click OK. In other versions of Outlook, clicking Tools>Options>Other>Auto Archive brings up a similar set of options.

4. Run the new rule on existing email folders. If you set a new rule that all emails over six months old will be archived, don’t let aging messages received before that rule was implemented continue to clog up your Inbox. Select the preferred mail folder, click Messages>Rules>180 Day, Auto Archive, and wait patiently while your email account reorganizes itself. Remember, you’ll have to perform this function on each desired folder; also, Outlook uses “Last Modified Date” to archive, not “Received Date.”

5. Want to access your archived emails? Simple — they’re waiting for you right on the left-hand column of folders - or under the list of .pst files on your computer - with all of your other mail folders. The key? They’re no longer taking up space in your mailbox.

Of course, archiving can’t cure all email diseases. If you access your mail via an Outlook Web App, any emails archived on your local computer won’t show up online — archiving them means they’re no longer hosted on the exchange server. And a .pst file or archived folder stored on your local hard drive is still susceptible to disastrous data loss if it’s not backed up as part of your backup and disaster recovery (BDR) plan.

Also, remember that Outlook is not a real email archiving solution — this QuickTip will simply help you free up storage space within the program, NOT keep your email secure via offsite backup or searchable across years of accumulated messages. To learn more about how CMIT Solutions can get your Outlook account back in fighting shape and provide unparalleled security for your email, stay tuned for Part Two of our Email Archiving QuickTip detailing the benefits of CMIT RADAR (Rapid Archiving, Discovery, and Recovery) next issue.

For professional IT support and technology services for your business, visit cmitsolutions.com/Encino or call (747) 239-2122. Andy Takieddine is the current president of CMIT Solutions — this QuickTip will help you free up storage space within the program.

The key? They’re no longer hosted on the exchange server. And a .pst file or archived folder stored on your local hard drive is still susceptible to disastrous data loss if it’s not backed up as part of your backup and disaster recovery (BDR) plan.

For membership information call 818.347.4737

You’re Kind of a Pig Deal

But How Do You Stack Up Amongst Your Competition?

MARKETING STRATEGY
BUSINESS EXECUTION
PUBLIC RELATIONS

1-800-527-3646 contact@coweconsulting.com coweconsulting.com
“Punk Rock Swap Meet” Benefits Local Children

Punk Rock Swap Meet, hosted by Woodland Hills resident Bob Oedy, takes place the Saturday, January 25, from 3 to 10:30 pm. Enjoy live music and buy a unique variety of items. The event is a fundraiser for underprivileged children in Los Angeles.

The event is open to all ages and include a full bar and seven bands, including The Dickies, Youth Brigade, Channel 3, Shattered Faith, Killroy, Glam Skanks, Infirmitaries and Something Ferocious. It takes place at Olov Hall, 21433 Strathern Street in Canoga Park. For more information visit Facebook.com/punkrockswapmeet.

Cirque du Soleil’s “VOLTA” Flies Into Town

Cirque du Soleil returns to Los Angeles with “VOLTA,” a captivating voyage of discovery! Inspired in part by the adventurous spirit that fuels the culture of street sports, “VOLTA” explores the themes of celebrating differences and unique qualities in a world where technology often isolates people from one another rather than freeing them. The name Volta refers to a sudden about-face, a change in emotion or idea often used in poetry. It also speaks to the jolt of energy delivered through the show. Energetic, urban and contemporary, “VOLTA” is a captivating voyage of discovery that showcases never-before-seen under the Big Top acrobatics in a visually striking world.

Driven by a stirring melodic score and inspired in part by the adventurous spirit that fuels the culture of street sports, “VOLTA” is a story of transformation. It is about being true to oneself, fulfilling one’s true potential, and recognizing one’s own power to make it possible. Ultimate freedom comes with self-acceptance, and with the liberation of the judgement of others.

Written and directed by Bastien Alexandre, with Jean Guibert as the director of creation, “VOLTA” weaves acrobatics in a visually striking world driven by a stirring melodic score, composed by Anthony Gonzalez from the international electronic group M83. “VOLTA” will perform under the Big Top at Dodger Stadium through February 23, 2020.

The San Francisco Chronicle gave VOLTA its highest rating: “A supercharged VOLTA soars!” The San Francisco Examiner said, “VOLTA is thrilling because of the acts. Period. They’re all totally fabulous.” Catey Sullivan in the Chicago Tribune wrote, “VOLTA is thrilling because of the acts. Period. They’re all totally fabulous.”

Tickets are now on sale by visiting cirquedusoleil.com/volta or calling 1-877-9CIRQUE (1-877-929-7783). Discover their repertoire. A visually arresting extravaganza … a vivid reminder of the world’s impossible beauty.

WINNETKA BOWL & ENTERTAINMENT CENTER

IT’S ALL HERE FOR YOU!

- RESERVE LANES ON-LINE https://winnetkabowl.net
- LEAGUES - ALL AGES (ASK ABOUT THE JUNIOR & SMART SCHOLARSHIP OPPORTUNITIES TO WIN MONEY FOR COLLEGE)
- 32 LANES with STATE-OF-THE-ART SCORING
- GAME ARCADE / 5 BILLIARDS / POOL TABLES
- PRO SHOP / SIGN UP FOR LESSONS
- CALL NOW TO PLAN YOUR NEXT PARTY ON THE LANES OR IN OUR PRIVATE PARTY ROOM
  winnetkabowlparties@outlook.com
- OPEN BOWLING Call for Lane Availability
- CALL 818.340.5190

BEST WESTERN CANOGA PARK INN

- BEAUTIFULLY RENOVATED ROOMS
- FULL BREAKFAST / EVENING RECEPTION
- FREE DRINK & BOWLING COUPONS
- OUTDOOR POOL & SPA / FITNESS CENTER
- HAVE YOUR NEXT MEETING HERE
  CONTACT EDDIE AT 818.883.1200

WINNETKA BOWL & ENTERTAINMENT CENTER IS A MEMBER OF THE GELB GROUP A FAMILY OF COMPANIES
20122 Vanowen St., Winnetka, CA 91306 Conveniently located near Pierce College & CSUN
**ENTERTAINMENT CALENDAR**

**Macy’s Sip & Scan Event**

Join Macy’s Westfield Fashion Square for a Wedding Gift Registry event on Thursday, January 23, from 7 to 9 pm to build your perfect registry while enjoying light refreshments and live music! Registry advisers, vendor experts, caterers, florists and more will be on hand to offer guidance and help you plan your big day. When you RSVP and show up that evening, your name will be entered in a drawing for a chance to win fun prizes. Visit Macys.com/registry and click on store events to register your name for the Sherman Oaks event, or call the store at 818.788.8350 x4444 or 4443.

**Raspberry Pi Series**

Kids 8 to 12 years old are invited to the Calabasas Library on Thursday, January 30 from 4:30 to 5:30 pm for an installment of their Raspberry Pi series. Participants will learn basic coding with Scratch on a Raspberry Pi computer as teen volunteers help kids create codes. The event will be in the Creativity Center and space is limited. For more information, please call the library at 818-225-7616 or email Karilyn Steward at ksteward@calabasaslibrary.org.

**SoCal Preparedness Day**

Now is the time to prepare your family for disasters big and small! Join the American Red Cross at Westfield Topanga on Sunday, January 26, from 10 am to 4 pm when Red Cross volunteers will be on hand to provide free preparedness resources to help you and your family say “I’m Ready.” In just a few minutes you’ll learn and how to administer lifesaving hands-only CPR, what you need in your emergency kit and how to make a disaster plan with your loved ones. You’ll even walk away with an “I’m Ready” sticker to help you show off your preparedness to the world! The event will take place on level 1 by Urban Outfitters.

**Lunar New Year Celebration Dishes**

Get the Lunar New Year off to a tasty start with dishes that represent luck, happiness, and fortune. Join Sur La Table Woodland Hills on Sunday, January 26, at 1 pm as you explore Chinese ingredients, then break out the wok and practice essential skills like sautéing, steaming and stir-frying. On the menu are soup dumplings, stir-fried long life noodles and vegetables plus Chinese long beans with chile and garlic. You’ll turn up the heat with chile and spices, then finish on a sweet note with ginger ice cream. Class is $69 per person and lasts around two to two and a half hours. RSVP now on the Woodland Hills page at surlatable.com.

**Goat Yoga!**

Grab a mat and get ready for a yoga class with the most unique partners: goats! Calabasas Commons will be hosting a special goat yoga class on Sunday, January 26, from 11 am to 12 pm. The adorable four-legged friends will stick around after class for plenty of cuddling and photos. The cost of class is $20 which can be paid day of in cash or venmo to @yogoatla but reservations should be made at https://www.yogoatla.com/event-details/the-commons-at-calabasas-goat-yoga-1-26. Please check in 15 minutes prior to the start of class.

**Goat Yoga!**

Celebrate Lunar New Year with this fun themed storyline at Calabasas Barnes and Noble on Saturday, January 25, at 11 am. The group will read How to Catch a Dragon by Adam Wallace. The wily dragon will have to avoid trap after trap as the kids run through paper lanterns, red envelopes, fireworks, and more! Join Storytime and color your own paper lantern to take home!

**IT’S ALL HERE**

**Adidas | The Body Shop | Lucille’s Smokehouse BBQ | Red Robin | Victoria’s Secret**
"Battle of the Bands" Takes the Stage January 27

The first round of competition begins Monday January 27th, 2020, at the Madrid Theatre in Canoga Park, for the "Rock the Valley" - Battle of the Bands. "Rock the Valley" - Battle of the Bands provides up-and-coming musicians an opportunity to showcase their talents and play original music for their audience while contributing to the cultural and social amenity of the music community.

The Valley Cultural Foundation along with their sponsors, Department of Cultural Affairs Los Angeles, Councilman Bob Blumenfield and the Madrid Theatre, are committed to promoting live music, acknowledging diversity and promoting opportunity for everyone.

The first round on January 27 includes: A V!V A 7 to 7:30 pm; Joan Apperson 7:45 to 8:15 pm; The Darryl Morris Band 8:30 to 9 pm; Stefan Carow & Days of Night 9:15 to 9:45 pm and Austin Jons & the Immortals 10 to 10:30 pm.

The second round on February 10 will feature Spectre Jones 7:45 to 8:15 pm; Pico de Gallo 8:30 to 9 pm; Illunis 9:15 to 9:45 pm.

The top two winners from each night will move onto the semifinals which will be held on February 17 and 24, with the finals on March 2.

Tickets now on sale through the Valley Cultural Foundation web site: www.valleycultural.org/battle-of-the-bands

Top prize is $1,000 and being the opening act at Councilman Bob Blumenfield’s July 4th Extravaganza Presented by Keyes Motors. Second prize is $500 and to be the opening act at a Concert on the Green concert. Third prize is $250 and to be the opening act at one concert at NoHo Summer Nights.

For more information call the Valley Cultural Foundation at 818-704-1358

Topanga Canyon Swap Meet
Set for Saturday in the Canyon

The Topanga Community Center will host a swap meet on Saturday, January 25, from 9 am to 3:30 pm. It will feature live music, chili cook off and pie contest. It will take place at the center, 1440 N. Topanga Canyon Blvd. For more information visit www.topantacommunitycenter.com.

West Valley Playhouse to Present “The Queen of Mystery Thrillers”

West Valley Playhouse Director Jon Berry has announced that the next production of the company will be Agatha Christie’s “Love From a Stranger.”

The cast includes Andrew Bonds, Nikki Gallagher, Diane Le Moine, Ari Litman-Weinberg, Bill Prescott, Ken Solo, Denice Stradling and McKenna Willis. The show will debut February 7 and run through March 1 on Fridays and Saturdays at 8 pm, Thursdays February 13 and 27 at 9 pm and Sundays at 2:30.

“Love From a Stranger” will take the stage at the Playhouse’s new location at 7507 Topanga Canyon Blvd., Canoga Park.

Tickets for all shows are available at the box office on Topanga, at www.wvplayhouse.com or on Facebook: westvalleyplayhouse.

"Big Party In a Little House"

Watch your Favorite Sports Games on 6 TV screens!

NOW POURING ON 12 TAPS!

HAPPY HOUR Mon-Sun 3-6pm

8524 Saugus Ave - Sherman Oaks
818-990-2583
Don't miss this **UNPRECEDENTED OPPORTUNITY** to change plans!

**OFFER ENDS FEBRUARY 15.**

- GUARANTEED ISSUE FROM ANY MEDICARE SUPPLEMENT PLAN

If you live in California and have any Medicare supplement plan from any company, you are guaranteed acceptance. No health questions.

They call it an "Underwriting Holiday"

**COMMONLY ASKED QUESTIONS**

"What's the difference between Plan F and G?"
With Plan F you have **no deductibles.** With Plan G you are responsible for the Part B deductible ($198 in 2020).

NO OTHER DIFFERENCES. SAME NETWORK (Any provider that accepts Medicare.)

"Are the core health benefits the same as on my current plan F?"
YES! IDENTICAL BENEFITS. SAME NETWORK

"Will my doctor accept this plan?"
Any provider that is “contracted with Medicare” anywhere in the USA should accept this plan.

<table>
<thead>
<tr>
<th>Age Range</th>
<th>BS Plan F EXTRA</th>
<th>BS Plan G EXTRA</th>
</tr>
</thead>
<tbody>
<tr>
<td>65 to 66</td>
<td>$163</td>
<td>$152</td>
</tr>
<tr>
<td>67 to 68</td>
<td>$177</td>
<td>$168</td>
</tr>
<tr>
<td>69 to 70</td>
<td>$197</td>
<td>$193</td>
</tr>
<tr>
<td>71 to 72</td>
<td>$214</td>
<td>$217</td>
</tr>
<tr>
<td>73 to 74</td>
<td>$232</td>
<td>$234</td>
</tr>
<tr>
<td>75 to 76</td>
<td>$268</td>
<td>$269</td>
</tr>
<tr>
<td>77 to 78</td>
<td>$302</td>
<td>$301</td>
</tr>
<tr>
<td>79 to 80</td>
<td>$341</td>
<td>$328</td>
</tr>
<tr>
<td>81 to 82</td>
<td>$373</td>
<td>$357</td>
</tr>
<tr>
<td>83 to 84</td>
<td>$390</td>
<td>$385</td>
</tr>
<tr>
<td>85 plus</td>
<td>$410</td>
<td>$404</td>
</tr>
<tr>
<td>64 or younger</td>
<td>$972</td>
<td>$937</td>
</tr>
</tbody>
</table>

Additional couples discount of 7% available if enrolled in identical plan.
if "New to Medicare" $25 discount available for first 12 months.
Plan F available only if you became eligible for Medicare before 1/1/2020

**Plan F Extra includes the following extras (not covered by Medicare), using network providers:**

- **SILVER SNEAKERS** – free gym network membership
- **VISION BENEFITS** – exam, eyewear allowance
- **HEARING BENEFITS** – annual exam + hearing aid discounted pricing
- **PERSONAL EMERGENCY RESPONSE SYSTEM** – device and monitoring

**Plan G Extra – Same benefits as Plan F Extra except:**

- Does not include Personal Emergency Response System
- Does Add $100 per quarter in FREE Over the Counter Items (stuff you purchase every month)

---

**PAUL DAVIS**
CA LICENSE #0M47932

Voted “Best Insurance Agent” for 18 years by readers of the Daily News 2002-2019!

Call us at 818-888-0880
www.pdinsure.com
HEALTHY NEW YEAR

KEEP YOUR BUSINESS HEALTHY!
Advertise in Valley News Group’s Four Papers
Valley Vantage
Warner Center News
Calabasas Enterprise
Encino Enterprise
Call 818.313.9545

Is Dry January Worth It?

As a New Year begins, one of the resolutions that seems to reign popular with many is the adoption of “dry January.” For some it serves as a kicking off point to vow to drink less in the New Year not only for the betterment of their health, but also for their wallet. Some simply use the dry period as a way to detox from the heavily fueled holiday season and give their liver a break. Yet all seem to claim that limiting alcohol intake is beneficial for their overall health. So is dry January actually a beneficial tool to be utilized? Experts say that it can be if done the appropriate way.

First, consumers are advised to look at their baseline drinking habits and then clearly state why they want to take part in “dry January.” For someone who drinks an occasional glass of wine, this deprivation period will most likely not do much for him or her. However, for someone with a more moderate drinking pattern, abstaining from alcohol abruptly could cause mild, but obvious, withdrawals like headaches. Yet, once that upsides, your body will be running clearer and cleaner.

Taking a one month break won’t recalibrate your drinking patterns or health, so it’s important to evaluate why you want to partake in dry January and the steps you plan to take once the month ends.

Perhaps the biggest benefit is seeing how your body functions (mentally, emotionally, physically, socially, etc.) without the dependence on alcohol. Are you sleeping better? Getting through your workouts smoother? Is your skin feeling more hydrated?

During this flu season, it could also be beneficial to your immune system. Intoxication can suppress your immune system, making you more susceptible to pathogens. Alcohol doesn’t kill all germs! Drinking less, consuming more water and having more energy could up your chances of not catching the flu.

It’s a kicking off point to vow to drink less in the New Year.

Once the month is up, evaluate how it went. Do you feel better? Have you lost weight? Saved money? Do you just miss the social aspect of drinking? While the pattern of indulge-abstain-indulge is never highly recommended by any health professional, dry January can be a crucial evaluating period if done correctly to see what your relationship with alcohol is. It’s also important to note that your tolerance will also be lower if you do decide to start drinking again so it’s important to return to it slowly.

While dry January is extremely popular, it doesn’t need to be the first month of a new year to evaluate your drinking habits. Pick any month that suits your schedule and see how much of a difference it could possibly make.

HEALTH AND WELLNESS UPDATE

COMMON VISION CHANGES THAT ROB OUR EYESIGHT

By Janey M. Rifkin

The importance of annual eye exams cannot be stressed enough, according to Dr. Rishi Singh, a retina specialist at the Cleveland Clinic Cole Eye Institute.

Focusing on small changes in one’s eyesight is the only sure way of detecting signs of more serious conditions that can permanently alter one’s vision. It’s also smart to eat a diet rich in leafy green vegetables and other foods high in antioxidants which may help slow the progression of age-related macular degeneration (AMD) and glaucoma as well.

As many as 11 million people in the U.S. suffer from some form of macular degeneration – which is an irreversible destruction of the macula – and the leading cause of blindness in adults over 60. The macula is the part of your retina responsible for central vision and tasks such as driving, watching TV, reading and distinguishing faces. You’re at higher risk if you smoke, are overweight, have poor dietary habits, or have a family history of AMD.

Glaucoma is the second leading cause of blindness in

(Continued to page 12)
By Allie Priore

The new year is a great time to check in with your goals and intentions for the year, including your health. Most people turn to physical activity when they think of health goals for the year. However, it is just as important to focus on your nutrition and what goes into your body as well.

A lot of people use the new year as a way to reset their system or detox with clean eating. Allowing your body this time to reset is beneficial for many reasons. You can rid your body of any toxins and start the new year on a cleaner slate. There are many different types of plans or tools to try, and depending on what your goals are, these can help you determine what you want to do. As with all major changes to your diet, be sure to check in with your doctor prior to changing any drastic eating habits especially if you are on certain medications.

Below are some of the various plans or tools for you to try:

Whole 30 — The basic idea is to eat solely whole foods, meaning nothing with added sugars, nothing with dairy and no alcohol. Due to its popularity there is a plethora of information online to help guide you in what you can and cannot eat, and even actual recipes you can follow. The plan is 30 days long and the goal is that at the end you learn to love how your body feels from eating foods that genuinely fuels it. Most people use this as a reset and after completing, introduce sugars, dairy and alcohol back into their lives. However, the cravings for those kinds of food and drinks have lessened and help you lead an overall healthier lifestyle.

Keto — The goal of this plan is to get your body into a state of ketosis which is a state where your body efficiently burns fat for energy. You achieve a state of ketosis from eating low carb and high fat foods. There is a lot of information available about how to achieve ketosis and what kinds of foods to eat or avoid so check online for more detailed information.

Intermittent Fasting — This eating pattern focuses more on when you eat rather than on what you are eating. When following this plan you are switching between periods of fasting and eating. There are multiple ways to implement your fast with the most popular breakdown being a fast of 16 hours with an eight hour eating window. However, some people fast two days a week by cutting down their caloric intake and some people fast for an entire 24 hours. You may already naturally fast if you tend to not eat breakfast and don’t eat past dinner. Perhaps none of the above seems like the right plan for you and that is okay. Focus on making the lifestyle changes that work for you. Maybe its something small like simply cutting back on sweets or increasing your water intake. Maybe you eliminate sugar completely from your diet.

Use this time to set your system - rid your body of any toxins and start the new year on a cleaner slate.

Use the New Year to Develop a New You!

Allie Priore is a certified Pilates instructor based in the LA area and has been a professional in the fitness industry for six years.
STATEPOINT CROSSWORD
THEME:
MOVIE CHARACTERS

ACROSS
1. CuraÁao neighbor
6. Lungful
9. Not on a rolling stone
13. British unemployment checks
14. Schiller's famous poem, e.g.
15. “Will comply” in radio communication
16. Opposite of liability
17. Napoleon Bonaparte or Louis Vuitton, e.g.
18. Embedded design
19. *Teen with telescopic powers
21. *Adventurous professor with fear of snakes
23. *He played it in “Casablanca”
24. Sign of escape
25. Steampunk decoration
28. Thanksgiving tubers
30. Fear of flying, e.g.
35. Bun baker
37. “CliffsNotes,” e.g.
39. Bound by oath
40. Nay, to a baby
41. Bread spreads
43. *She takes on PG&E
44. Sacrificial spot
46. Wedding promise?
47. Not yet final
48. Eats between meals
50. Blood-related problem
52. Ship pronoun
53. Diamond’s corner
55. Be obliged
57. Name before X
61. *Orphan who wanted more gruel
64. Love between AbÈlard and HÈloÔse
65. Pitching stat
67. Nostrils, anatomically speaking
69. Pine
70. Fleur-de-____
71. Novelist Wharton
72. * Adopted orphan of Green Gables
73. Auction set
74. Like a disputable neighborhood

DOWN
1. Palindromic title
2. CISC alternative
3. *Female Superman foe alongside General Zod
4. Afrikaners’ ancestors
5. Off course
6. First-rate
7. Nuptial agreement
8. Version of a song
9. Mr. Bean’s ride
10. Paelia pot
11. Diagnostic test
12. Bean that rhymes with Goya
15. Distance from side to side, pl.
20. Insect in adult stage
22. Tiny bite
24. Most vital part
25. *A barbarian
26. Convex molding
27. Ladies and ____, for short
28. Like a disreputable neighborhood
29. *a.k.a. The Mayor of Castro Street
31. *Hutch actor in 2004’s “Starsky & Hutch”
32. *Famous Frankenstein portrayer
33. Like Michael Collins
34. *One of Miss Hannigan’s orphans
36. Russell Crowe’s Biblical role
38. ____ of the trade
42. Bar seat
45. Type of realistic baby doll
49. "Pizzeria owner in "Do the Right Thing"
51. Strings
54. Offactory sensation
56. Avoid
57. Poet Angelou
58. Flock’s affirmation
59. Bank’s provision
60. Dry or salt
61. Brewer’s kiln
62. Great Lake
63. Railied, shortened
65. Spanish river
68. Like a wallflower

Chick-fil-a Opening at Ventura and Winnetka
(Continued from page 1)

Oak have led many Woodland Hills residents to worry about the traffic complications associated with a drive-through on a busy street. Several residents pointed to the back-up from the In-and-Out just east down the boulevard during peak dining periods.

The ingress from Winnetka actually backs up to the eastbound freeway offramp, which could cause major traffic tie-ups.

However, the project was approved by the city with a Mitigated Negative Declaration, meaning they found no substantial detrimental effects from the plan as submitted.

The new 5,278 square foot restaurant requires 53 auto parking space and six bicycle parking spaces. However, the city approved that in lieu of seven auto spaces the restaurant will provide 28 bicycle parking spaces.

Vision Changes
(Continued from page 10)

the U.S. “There are excellent treatments to prevent vision loss from glaucoma,” says Cleveland Clinic Ophthalmologist Dr. Craig See. However, a more severe type, acute angle-closure glaucoma, is a medical emergency and must be treated immediately. Besides age, your risk is higher if you have a family history of the disease.

There’s another certainty, changes in your vision. Annual checkups are imperative.

Janey Rifkin is a locally based journalist; executive editor of a national magazine; and a syndicated health columnist.

Calabasas Public Safety Commission to Meet

The Calabasas Public Safety Commission will meet on Monday, January 27, at 4 pm. The commission will meet at council chambers at City Hall, 100 Civic Center Way. The meeting will also be televised on CTV.

Hike the Santa Susana Mountains

The Foundation for the Preservation of the Santa Susana Mountains welcomes the public to a hike on the Miranda Loop at the Santa Susana Pass Historic Park. The hike starts from the Andora Avenue Trailhead this Sunday, January 26, at 11 am.

Home Depot Offers Do-It-Yourself Class

Home Depot West Hills is offering a free workshop on “Installing Tile Backsplash.” Learn how to do a professional job from the professionals! The class will be held Saturday, January 25, at 10 am at 22855 Victory Blvd.

In-house engineering AND construction!

We have the experience necessary to complete any structural repair upgrade in a cost-effective manner.

Give us a call, we can help.

Structural repairs and upgrades on hillside homes

Alpha Structural, Inc. | (333) 522-4853 | www.alphastuctural.com
Free Program
Addresses
Coyotes Among Us

Wildlife educator Dana Stangel of Teranga Ranch will lead the discussion on “Coyotes Among Us” on Monday, January 27 at 7 pm.
Do you have questions about coyotes? Have you been concerned about their way they look at you? Will your fence keep them out? Why do they yip in unison? Learn the answers to these questions and more about living near urban coyotes.

Stangel will explore the natural history of the urban coyote and talk about the current situation regarding coyotes, pets, and backyards. She will also demonstrate various humane hazing techniques and demonstrate backyard wildlife deterrents.

The seminar will be held at the Rockpointe Clubhouse, 22300 Devonshire (at Valley Circle) in Chatsworth.

The program is sponsored by the Santa Susana Mountain Association. For more information contact Tim Fargo, City Planner at (818) 374-9911.

Public Hearing Set on Adler Project

A public hearing on the “Adler Project” at 21031 West Warner Center Lane has been set for Tuesday, February 11.

The proposed project includes the phased demolition of the existing buildings and other improvements and the phased construction of a mixed-use development consisting of 10 new buildings on eight lots varying in height from approximately 35 feet to 350 feet in height. The project includes a private street (Warner Center Lane) from Burbank Boulevard through De Soto Avenue. The project would be constructed in eight phases and includes a total of approximately 2,634,268 square feet of floor area, with approximately 1,175,513 square feet of residential floor area (approximately 45 percent of the total floor area) and approximately 1,458,755 square feet of non-residential floor area, consisting of office, retail, and hotel uses (approximately 55 percent of the total floor area). The project’s residential uses consist of approximately 1,009 multi-family units, including 841 apartment units (approximately 53 of which will be work-live units, as defined in Section 4 of the WC2035 Plan) and approximately 168 condominium units (approximately 15 of which will be work-live units). The project’s non-residential uses include approximately 1,140,746 square feet of office space, approximately 7,731 square feet of ground-floor restaurant space, approximately 15,741 square feet of ground-floor retail space, approximately 35,311 square feet of ground-floor restaurant and/or retail space, approximately 26,762 square feet of ground-floor office and/or retail space, approximately 4,068 square feet of community space, and an approximately 157,535 square-foot hotel with 228 hotel rooms.

The hearing will be held at 10:30 am at the Marvin Braude Center, 1B first floor conference room, 6262 Van Nuys Blvd., Van Nuys. For more information contact Tim Fargo, City Planner at (818) 374-9911.

GREAT SPACE - ONE MONTH FREE

With Year’s Lease • On Approved Credit • All Properties Subject to Availability

Choose from our 16 Outstanding Properties in the Valley

♦ Specializing in 500-2500 square feet of office space
♦ FREE tenant and guest parking in all of our buildings
♦ Month-to-Month and Yearly Leases Available

GELB GROUP
A Family of Companies
6200 Canoga Avenue, Suite 201
Woodland Hills CA 91367

www.gelbgroup.net
For Leasing Information - Call Lisa
818-377-2275
The following person(s) is (are) doing business as Valley Vantage 1-9, 16 - 2020

Dale E. Cahill. Three trailer beds, tool box, wine racks, 40+ framed pictures/pics., postcard, 4+ bags of groceries, 6+ kitchen cabinets.

The person(s) doing business as Community Cross, 22731 Vision St, Chatsworth, CA 91311. This statement was filed with the County Clerk of Los Angeles on 1/17/20. The Fictitious Business Name Statement expires five years from the date it was filed in the office of the Office of the County Clerk. A new Fictitious Business Name Statement must be filed before that time. The filing of this statement does not itself authorize the use in this state of a Fictitious Business Name in violation of the right of another under Federal, state or common law (see Section ET SEQ., Business and Professions Code).

Notice of Public Sale

The person(s) doing business as Jobz Bean, 2722 E Tasman Dr, Chino Hills, CA 91709. This statement was filed with the County Clerk of Los Angeles on 12/29/19. The Fictitious Business Name Statement expires five years from the date it was filed in the office of the Office of the County Clerk. A new Fictitious Business Name Statement must be filed before that time. The filing of this statement does not itself authorize the use in this state of a Fictitious Business Name in violation of the right of another under Federal, state or common law (see Section ET SEQ., Business and Professions Code).
SUPERIOR COURT OF CALIFORNIA, COUNTY OF LOS ANGELES

PERSON OBJECTING TO THE NAME CHANGES DESCRIBED ABOVE MUST FILE A WRITTEN OBJECTION.

If a written objection is timely filed, the court may grant the petition without a hearing. If no written objection is timely filed, the court shall order the person objecting to the name changes described above to file a written objection that includes the reasons for the objection no later than ten court days before the matter is scheduled to be heard and must appear at the hearing to show cause why the petition should not be granted. If no written objection is timely filed, the court may grant the petition without a hearing.

ORDER TO SHOW CAUSE FOR CHANGE OF NAME

TO ALL INTERESTED PERSONS: Petitioner(s): Muhammad A. Moody filed a petition with this court for a decree changing names as follows:

Present Name: Muhammad A. Moody
Proposed Name: Ali M. Ali

THE COURT ORDERS that all persons interested in this matter shall note for the hearing indicated below to show cause why, if any, the petition for change of name should not be granted. Any person objecting to the name change described above must file a written objection that includes the reasons for the objection no later than ten court days before the matter is scheduled to be heard and must appear at the hearing to show cause why the petition should not be granted. If no written objection is timely filed, the court may grant the petition without a hearing.

NOTICE OF HEARING: Date: 03-09-2020; Time: 8:30 am; Dept.: E. The file will be called for a hearing on this matter before the Honorable Judge David Mavis. Filing of a statement of objection does not itself authorize the use in this state of a Fictitious Business Name Statement.

The following person(s) is (are) doing business as Bridges Entertainment; Bridges Talent, 5264 Satsuma Ave #19, North Hollywood, CA 91601. This statement was filed with the County Clerk of Los Angeles on 1/9/20. The Fictitious Business Name Statement expires five years from the date it was filed in the office of the County Clerk. A New Fictitious Business Name Statement must be filed before that time. The filing of this statement does not itself authorize the use in this state of a Fictitious Business Name in violation of the right of another under Federal, state or common law (see Section ET SEQ., Business and Professions Code) 1-16, 23, 30, 2-6, 2020.

ORDER TO SHOW CAUSE FOR CHANGE OF NAME

TO ALL INTERESTED PERSONS: Petitioner(s): Beauty for all, Inc. filed a petition with this court for a decree changing names as follows:

Present Name: Beauty for all, Inc.
Proposed Name: Beauty for all, Inc.

THE COURT ORDERS that all persons interested in this matter shall note for the hearing indicated below to show cause why, if any, the petition for change of name should not be granted. Any person objecting to the name change described above must file a written objection that includes the reasons for the objection no later than ten court days before the matter is scheduled to be heard and must appear at the hearing to show cause why the petition should not be granted. If no written objection is timely filed, the court may grant the petition without a hearing.

NOTICE OF HEARING: Date: 03-09-2020; Time: 8:30 am; Dept.: E. The file will be called for a hearing on this matter before the Honorable Judge David Mavis. Filing of a statement of objection does not itself authorize the use in this state of a Fictitious Business Name Statement.

The following person(s) is (are) doing business as Add Colors to the World of Silk, 21333 Lassen St., Unit 8A, Chatsworth CA 91311. This statement was filed with the County Clerk of Los Angeles on 1/6/20. The Fictitious Business Name Statement expires five years from the date it was filed in the office of the County Clerk. A New Fictitious Business Name Statement must be filed before that time. The filing of this statement does not itself authorize the use in this state of a Fictitious Business Name in violation of the right of another under Federal, state or common law (see Section ET SEQ., Business and Professions Code) 1-6, 20-3, 2-6, 2020.

The following person(s) is (are) doing business as KL Cards, 12215 Reseda Blvd # C, Canoga Park, CA 91304. This statement was filed with the County Clerk of Los Angeles on 12/10/19. The Fictitious Business Name Statement expires five years from the date it was filed in the office of the County Clerk. A New Fictitious Business Name Statement must be filed before that time. The filing of this statement does not itself authorize the use in this state of a Fictitious Business Name in violation of the right of another under Federal, state or common law (see Section ET SEQ., Business and Professions Code) 1-6, 20-3, 2-6, 2020.

ORDER TO SHOW CAUSE FOR CHANGE OF NAME

TO ALL INTERESTED PERSONS: Petitioner(s): Andrea Mosedi filed a petition with this court for a decree changing names as follows:

Present Name: Andrea Mosedi
Proposed Name: Andrea Mosedi

THE COURT ORDERS that all persons interested in this matter shall note for the hearing indicated below to show cause why, if any, the petition for change of name should not be granted. Any person objecting to the name change described above must file a written objection that includes the reasons for the objection no later than ten court days before the matter is scheduled to be heard and must appear at the hearing to show cause why the petition should not be granted. If no written objection is timely filed, the court may grant the petition without a hearing.

NOTICE OF HEARING: Date: 03-09-2020; Time: 8:30 am; Dept.: E. The file will be called for a hearing on this matter before the Honorable Judge David Mavis. Filing of a statement of objection does not itself authorize the use in this state of a Fictitious Business Name Statement.

The following person(s) is (are) doing business as Value Cleaners, 10345 Sepulveda Blvd., Mission Hills, CA 91340. This statement was filed with the County Clerk of Los Angeles on 12/18/19. The Fictitious Business Name Statement expires five years from the date it was filed in the office of the County Clerk. A New Fictitious Business Name Statement must be filed before that time. The filing of this statement does not itself authorize the use in this state of a Fictitious Business Name in violation of the right of another under Federal, state or common law (see Section ET SEQ., Business and Professions Code) 1-6, 20-3, 2-6, 2020.

ORDER TO SHOW CAUSE FOR CHANGE OF NAME

TO ALL INTERESTED PERSONS: Petitioner(s): Amazing Business Services, Inc. filed a petition with this court for a decree changing names as follows:

Present Name: Amazing Business Services, Inc.
Proposed Name: Amazing Business Services, Inc.

THE COURT ORDERS that all persons interested in this matter shall note for the hearing indicated below to show cause why, if any, the petition for change of name should not be granted. Any person objecting to the name change described above must file a written objection that includes the reasons for the objection no later than ten court days before the matter is scheduled to be heard and must appear at the hearing to show cause why the petition should not be granted. If no written objection is timely filed, the court may grant the petition without a hearing.

NOTICE OF HEARING: Date: 03-09-2020; Time: 8:30 am; Dept.: E. The file will be called for a hearing on this matter before the Honorable Judge David Mavis. Filing of a statement of objection does not itself authorize the use in this state of a Fictitious Business Name Statement.

The following person(s) is (are) doing business as Zone of Beauty, 201 E. Magnolia Blvd., Suite 506, Glendale, CA 91206. This statement was filed with the County Clerk of Los Angeles on 12/12/19. The Fictitious Business Name Statement expires five years from the date it was filed in the office of the County Clerk. A New Fictitious Business Name Statement must be filed before that time. The filing of this statement does not itself authorize the use in this state of a Fictitious Business Name in violation of the right of another under Federal, state or common law (see Section ET SEQ., Business and Professions Code) 1-16, 23, 30, 2-6, 2020.

ORDER TO SHOW CAUSE FOR CHANGE OF NAME

TO ALL INTERESTED PERSONS: Petitioner(s): Valley News Group, January 23, 2020, Page 15 filed a petition with this court for a decree changing names as follows:

Present Name: Valley News Group, January 23, 2020, Page 15
Proposed Name: Valley News Group, January 23, 2020, Page 15

THE COURT ORDERS that all persons interested in this matter shall note for the hearing indicated below to show cause why, if any, the petition for change of name should not be granted. Any person objecting to the name change described above must file a written objection that includes the reasons for the objection no later than ten court days before the matter is scheduled to be heard and must appear at the hearing to show cause why the petition should not be granted. If no written objection is timely filed, the court may grant the petition without a hearing.

NOTICE OF HEARING: Date: 03-09-2020; Time: 8:30 am; Dept.: E. The file will be called for a hearing on this matter before the Honorable Judge David Mavis. Filing of a statement of objection does not itself authorize the use in this state of a Fictitious Business Name Statement.

The following person(s) is (are) doing business as ANG Public Relations and Marketing, LLC, 577 Linda Road, Canyon Country, CA 91389. This statement was filed with the County Clerk of Los Angeles on 1/9/20. The Fictitious Business Name Statement expires five years from the date it was filed in the office of the County Clerk. A New Fictitious Business Name Statement must be filed before that time. The filing of this statement does not itself authorize the use in this state of a Fictitious Business Name in violation of the right of another under Federal, state or common law (see Section ET SEQ., Business and Professions Code) 1-6, 20-3, 2-6, 2020.

ORDER TO SHOW CAUSE FOR CHANGE OF NAME

TO ALL INTERESTED PERSONS: Petitioner(s): Space for rent, 1544 Reseda Blvd, Suite 100, Reseda, CA 91335 filed a petition with this court for a decree changing names as follows:

Present Name: Space for rent, 1544 Reseda Blvd, Suite 100, Reseda, CA 91335
Proposed Name: Space for rent, 1544 Reseda Blvd, Suite 100, Reseda, CA 91335

THE COURT ORDERS that all persons interested in this matter shall note for the hearing indicated below to show cause why, if any, the petition for change of name should not be granted. Any person objecting to the name change described above must file a written objection that includes the reasons for the objection no later than ten court days before the matter is scheduled to be heard and must appear at the hearing to show cause why the petition should not be granted. If no written objection is timely filed, the court may grant the petition without a hearing.

NOTICE OF HEARING: Date: 03-09-2020; Time: 8:30 am; Dept.: E. The file will be called for a hearing on this matter before the Honorable Judge David Mavis. Filing of a statement of objection does not itself authorize the use in this state of a Fictitious Business Name Statement.
UCLA pediatrics – the right start for kids

Making your child’s health a priority is now easier than ever. With pediatric care in Calabasas, UCLA doctors are where you need us, when you need us. Because when it comes to your child’s health, we go out of our way to make sure you never have to.

**Calabasas**
26585 W. Agoura Road, Suite 360
Calabasas, CA 91302
818-592-2320
uclahealth.org/calabasas

- General Pediatrics
- Pediatric Gastroenterology
- Pediatric Neurology
- Pediatric Pulmonology

UCLA Health
it begins with U

1-800-UCLA-MD1 (1-800-825-2631)